


The nest ol 
macworld 

by David Pogue 
= -= IDG 
BOOKS 
WQe!JMil)l 

IDG Books Worldwide, Inc. 
An International Data Group Company 

Foster City, CA • Chicago, IL • Indianapolis, IN 
Braintree, MA • Dallas, TX 



This is a special excerpt from 
Macworld Mac FAQs 

l>ublished by 
IDG Books Worldwide, Inc. 
An International Data Group Company 
919 E. H illsdale Blvd. 
Suite 400 
Foster City, CA 94404 

Copyright © 1995 By IDG Books Worldwide, Inc. All rights reserved. No part of this book may be 
reproduced or transmitted in any form, by any means (electronic, photcopying, recording, or 
o therwise) wi thout the prior w ritten permission of the publisher. 

For general information on IDG Books Worldwide's books in the U.S .. please call our Consumer 
Customer Service deparlment at 60().762-2974. For reseller information,m including discounts and 
premium sales, please call our Reseller Customer Service department at 60().434-3422. 

For sales inquiries and special prices for bulk quantities, write to the address above or call IDG Books 
Worldwide at 415-655-3200. 

For information on using IDG Books Worldwide's books in the classroom, or for ordering 
examination copies, contact )im Kelly at 600-434-1066. 

Umit o f Liabil ity/ D isclaimer of Warrant)': The author and publisher have used their best effor ts in 
preparing this book, IDG Books Worldwide, Inc., and the author make no representation or 
warranties with respect to the accuracy or completeness of the contents of this book and specific.1lly 
disclaim any implied warranties of merchantability or fi tness for any panicular purpose and shall in no 
event be liable for any loss of profit or any other commercial damage, including but not limited to 
special, incidental, consequential, or other damages. 

Tmdemarks: All brand names and product names used in this book are trademarks. registered 
trademarks, or trade names o f their respective holders. IDG Books Worldwide is not associated w ith 
any product or vendor mention in this book. 

--..-E is a trademark under exclusive 
IDG license to IDG Books Worldwide, Inc., 
~-~~ from International Data Group. Inc. 

Credits Editorial Assistant 
Nate Holdread 

Production Director 
Publisher Beth jenkins 
Brenda Mclaughlin 

Supervisor Project 
Acquisitions Manager Coordination 
Gregory Croy Cindy L. Phipps 

Acquisitions Editor l'rc-l'rcss Coordinator Steve 
NtlllL}' E. Dunn pc.1kc 

llrand M anager Associate Pre-Press 
Pradcepa Siva Coordinator 

Editorial Director 
Tony Augsburger 

Mary Bednarek Media/ Archive Coordinator 

Editorial Managers 
Paul Belcastro 

Mary C. Corder l'rnjcct Editor 
1\ndy Cummings Jim Grey 

Editorial Execu tive Assistant Technical Reviewer 
lo<li Lynn Semling leff Robbin 

Production Stafi 
Gina Scott 
Carla C. Radzikinas 
Patricia R. Reynolds 
Melissa D. Buddendeck 
Dwight Ramsey 
Robert Springer 
Theresa Sanchez-Baker 
Kathie Schnorr 
Chris Collins 
Angie 1-lunckler 
Mark Owens 

Proofreader 
Henry Lazarek 

Indexer 
Uz Cunningham 

Book Design 
jo Payton 



Introduction 3 

Introduction 

What's FAQ? 
It stands for Frequently Asked Questions. 
I didn't make this up, by the way. The term FAQ is a by-product of the 
Internet explosion, when millions of first-time modem owners began 
to cruise that great worldwide bulletin-board. To keep from having to 
answer the same questions over and over again, veteran Internauts 
would type up all the obvious questions with patient, beautifully 
explained answers. Each one- or two-page file of Q's and A's was 
called, of course, a FAQ sheet. FAQ sheets started springing up faster 
than Boston Chicken outlets. 
Of course, I run a great risk calling thls book Mac FAQs. I mean, FAQ 
isn't as well-known a 90's term as, say, O.f. or infomercial. At this very 
moment, somebody's in a bookstore somewhere asking for a book 
called Mac Facts, or Mac Fax, or Max Factor. 
But millions of people have the same questions about the Mac. Trouble 
is, there's no central p lace to go for the answers. Macworld Mac FAQs, 
tJ1e real book, contains tl1e 500 most frequently asked Mac questions on 
earth; the booklet you're now reading contains a tempting assortment 
of 50 such questions. 
Oh yeah- and the answers. 

David Pogue 
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About the Author 
David Pogue g raduated Sll/1111111 wm /nude from Ya le in 1985. After 
spending six years conducting and arranging Broadway musicals, he 
began writing "The Desktop Critic" column for Mncworld magazine; 
teaching the Mac to such celebs as Mia Farrow, Gary Oldman, Stephen 
Sondheim, and Carty Simon; and authoring books like Mncs for 
Dummies, which has been the #1 bestselling Macintosh book for four 
straight years. (A sequel, More Mncs for Dummies, debuted in 1994. And 
for people whose thirst for Mac wisdom remains unslaked, Pogue also 
co-wrote the encyclopedic, 1100-page Mncwor/d Mnc & Power Mnc 
SECRETS, now in its 3rd Edition; it comes with, among 45 other pro­
grams, the complete Now Utilities.) 
His first novel, a techno-thriller called Hard Drive, was called "a notable 
book of the year" by the New York Times; a new thriller is in the works. 
David is a regular panelist at the Macworld Expo and user-group gath­
erings nationwide. He's been profiled on "48 Hours," in the New York 
Times, and in USA Today. 

About the Book 
The real, actual 420-page book, Mncworlrl Mnc FAQs, contains over 500 
frequently asked questions- gorgeously organized and expertly 
answered.lt includes dozens of the World's Dumbest Tech-Support 
Call stories (like the handful in this booklet), a master list of keystroke 
shortcuts in all the popular programs, a list of phone numbers for a ll 
major software companies, and enough funny, interesting information 
to keep your eyebrows permanently raised. 
If it's not at your local bookstore, they' ll be happy to order it for you. 

Or save money by using the coupon at the end of this booklet. 
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Chapter 1: First-Timer FAQs 

How can I avoid losing files? 
A. Always click the Desktop button before you save. 
Suppose you've just written a letter in ClarisWorks. When you choose 
Save for the first time, click the Desktop button before you click Save 
(see Figure 1). 
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Then, when you quit 
ClarisWorks at the end of 
the day, the new file you 
made will be sitting right 
there in front of you (see 
Figure 2). Now it's a simple 

matter to drag it into an appropriate folder. Do this regularly, and you'll 
never lose another file. 

Figure 2: Your new file will be happily waiting for you, safely 
not buried in a folder somewhere. Put it where you want it. 

Incidentally: if you use a Per forma or System 7.5, 
you can automatically avoid losing things. Turn on 
your "Save new documents into the Documents 
folder'' option in the Performa or General Controls 
control panel, and all new documents will go 
straight into your desktop Documents folder. 

Is it better to turn my Mac off every night? 
A. Only for convenience or conscience; not to protect 
your equipment. 
Some engineers maintain that the heat of leaving the Mac on all the 
time weakens the components, shortening their life. The others argue 
that the daily surge of electr icity- from switching the machine on­
is far worse. 
There's an economic argument, too. Turning the Mac off at night saves 
hundreds of dollars' worth of electricity per year- and is better for the 
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environment. (The "sleep mode" of recent Power Mac models protects 
the screen and hard drive by letting them rest - but don't be fooled; 
sleep mode doesn't conserve electricity.) 

The answer, then, is to do whatever's most convenient. Handy compro­
mise: tum off the monitor at night. (It's perfectly OK for the computer to 
be on while the screen is off.) That way you don't have to wait for start­
up the next morning; no surge of power goes through the machine 
every day; a major power consumer is off; and your monitor's phos­
phor coating lasts longer. 

Should I get a Mac no~ or wait for the next model? 
A. Buy it now, unless Apple' s coming out with a new 
model next week. 
Face it: any computer is going to lose half its value and fall technologically 
behind-the-times in six months. The cycle never ends. This bit about ever­
faster and ever-cheaper computers isn' t specific to Mac, by the way. You'd 
fight the same technological dragon if you were an IBM-compatible fan. 
Therefore, the answer is: buy the Mac now. In the time you would have 
waited for the next great thing to come along, you'll use it, have fun, 
and get a lot done. 
On the other hand, you don't want to be dumb about it. Check to see 
if Apple's coming out with something newer and better soon. Way 1: 
Ask the people at a computer store. It's free, but not totally trustworthy; 
these guys are often fairly clueless about Macs. Way 2: If your news­
paper is metropolitan enough to carry computer ads, watch the Mac 
prices as the weeks go by. When a certain model's price suddenly 
tumbles, it's because a new model is about to replace it. Way 3: Sign 
onto Macworld Online (llttp://www.macworld.com) or America Online 
(keyword: macworlrl) and leave a question in the message area: "1 want 
to buy a_. Is now a good time?" You'll get a good answer within a 
day. Or visit the Mac Week site on the World Wide Web; it's a magazine 
specializing in leaks from Apple. 

It says //Not enough memory." Should I throw some 
stuff away? 
A. Nope - that won't help. 
If you throw away files you don' t need anymore, you'll make more disk 
space. But you won't affect your computer's memory at all. (Memory is 
a fast, electronic, temporary kind of storage that gets used up when you 
launch one of your programs- and restored to availability only when 
you Quit a program. A disk, such as your hard drive, is where stuff is 
safely stored even when the computer is off.) 
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How can I get rid of the half-inch black border on my 
monitor? 

A. You can't. 
Using the little knobs tucked somewhere on your monitor, you cnu 
make the picture fil l more of the glass. But you won't ge t more desktop 
area (that shows, for example, more of a page at a time); instead, you'll 
only be enlarging the picture that's there. See Figure 3. 

What you have now. \IVhat you want (more 
viewing area). 

What you can get (same 
viewing area, larger do ts.) 

Figure 3: You can blow up your p icture, but you won' t see any more. 

Monitor companies say that if they made the picture fill the g lass edge­
to-edge, the picture would be distorted around the edges. (They also 
want to boos t their sales of bigger monitors.) 

What do the different controls on a window do? 

A. They're at the corners and edges of every 
Macintosh window. Here's a summary (see Figure 4). 

Click to on~ke Drag to 00-click to see 
the window go move the what iolders this 
away. entire one's inside of. 

Click to enlarge the 
window (to show as 
much as possible. 

Click a label heading to change 
how the i tems are listed (biggest 
first, for example). 

Drag this box to move vertically 
through the window contents. 

Drag this box to 
move siclewa)'S 
through the 
window contents. 

Click in the gray 
part to jump 
sideways through 
the window 

Dr.1g diagonally Click repeatedly (or hold down 
to resize the button) 10 scroll through the 
window. window contents. 

contents. 

Figure 4: The various ways you can push, pull, or tug a window. 
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The controls you'll probably use the most o ften are the title bar (le ts 
you move the window), the zoom box (upper-right, which expnuds the 
window as large as necessary to see its contents), and the close box 
(upper-left, which closes the window). 

I ejected a disk, but the Mac keeps asking for it back! 
A. And it always will, too, if you keep using the Eject 
Disk command. 
Do not use the Eject Disk command (in the Special menu) to eject a 
disk. If you do, the disk's ghostly image remnius on the screen- even 
after you eject the disk. And the Mac stubbornly asks you to re-insert 
the disk before it lets you proceed with your regularly scheduled life. 
Instead, highlight the disk and choose Prtl Awny from the File menu. 
That pops the disk out. 

Alternatively, you cCin drCig the floppy-disk's icon to the Trash. You 
might feel CIS though you're Clbout to erCise the disk, but actuCI IIy the 
disk pops right out. 
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Chapter 2: How to Do It 

How do I connect my StyleWriter, my QuickCam, and 
a modem all to the same jack? 
A. Get a manual switch box for $25, or an automatic 
one for several hundred dollars. 
Several different kinds of Mac gear all are supposed to be plugged into 
your modem jack: the modem, MIDI synthesizers, label printers, the 
StyleWriter, and so on. What's a Mac fan to do? 

The simplest and least expensive solution is to buy a manual A/B 
switch box from one of the Mac mail-order places. You can even get an 
A/B/C/D switch if you have a lot of gear. Just turn the knob (or punch 
a button) on the box to specify which gadget you want to use. 

If you can't stand manually switching devices, you can buy a NuBus 
card that provides additional modem jacks. Or, you can get something 
called the Port Juggler, an external box with four modem ports. It's sup­
posed to switch the Mac's attention from one to another automatically, 
depending on which program you're using. (A significant number of 
people can' t get it to work, but other people report good luck. Buy it 
from a place that accepts returns.) 

How do I make symbols, like tt and ¥and ©? 
A. Let Key Caps be your guide. 
There it is, right in your Apple menu: the desk accessory called Key 
Caps. Open it. If you hold down your Option key, you'll see the com­
plete map showing where all those useful symbols are hidden. By 
lifting your finger off the Option key as you stare at the symbol you 
wanted, you can figure out what normal letter key to type to produce 
it (when the Option key is down). 

Don' t forget, too, that each foll t may have different symbols. Change 
fonts using the Key Caps menu, which appears when Key Caps is open. 
And if it's too hard to remember that Command-Shift-Option-Caps 
Lock-7 produces some desperately needed Swahili diacritical marking, 
click the onscreen symbol when you see it. It appears in the text strip at 
the top of the Key Caps window, where you can select it, copy it, and 
paste it into whatever document you're working on. 

How do I connect the Mac to a TV or VCR? 
A. With a $250 adapter. 
Mac models with the le tters AV in their names, as well as certain Macs 
(such as the 8500, or the 630 or 5200 series with the optional Apple TV 
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card), can hook directly to a TV or VCR. All you need is a male-to-male 
RCA cable (which probably came with your Mac) for your VCR's Video 
In jack. 

AU other models require an adapter, known as an NTSC converter. Any 
mail-order place w ill sell you one; the LTV Portable (Focus Enhance­
ments) is one of the best known. 

This NTSC converter p lugs into your Mac's monitor jack. (Of course, if 
your Mac doesn' t llnve a monitor jack, such as the PowerBook 150 or the 
SE/30, you're out of luck.) Another wire goes to the VCR or TV, and a 
third gets plugged into a wall power socket. Your regular Mac monitor 
just sits there, gathering dust- unless you happen to have purchased 
one of the "Pro" converters, which have an extra jack for your monitor. 

None of these methods make your Mac's image look as good on TV as it 
does on its regular monitor. Don't forget that TV was invented over 50 
years ago; the quality of the newer technology blows away the feeble offer­
ings of a television. 
Still, a TV is a handy (and common) large-screen appliance. For people 
making presentations on the road or using the Mac in a classroom, get­
ting the Mac on TV mig ht just be the ticket. 

How do I take a picture of the screen? 

A. Press Command-Shift-3. 
You'll hear a satisfying camera-shutter sound. After a moment of 
frozen-cursor syndrome, you'll find a new file called Picture 1 on your 
hard drive. (If you take more snapshots, they' ll be called Picture 2, 
Picture 3, and so on.) Double-click the Picture file to open it in Teach­
Text or SimpleText. At th is point, you can do two things: 
1. Be confused. Be very confused. The menus and icons you're 

seeing now aren't real icons and menus- they' re just a pic­
ture of them, in PICT graphics format. Resist the temptation 
to pull down these menus. 

Figure 5: Viewing a 
Picture 1 file (a screen 
shot) in SimpleText 
can be disorienting. 
You're looking at a 
picture of the desk­
top, not the real 
desktop. In this screen 
shot. the Trash can on 
the right is the real 

Trash - and the 
menus at the very top 
are the real menus. 
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2. By dragging your cursor across the image and then choosing Copy 
rrom the Edit menu, you can grab a selected portion of the image and 
paste it into a word-processing document. (Incidentally, this is pretty 
mud1 how I illustrated this book.) 

11Deliciou$," he said. 



12 MacFAQs 

How can I put a picture on my desktop? 

A. You need After Dark or Decor. 
After Dark (version 3 or later) is best known as a screen saver. But its 
WallZapper feature lets you turn any PICT (graphics) file into a back­
drop (Figure 6). For the first time, After Dark does something while 
you're using your Mac. 

Figure 6: Banish thai boring 
desktop pattern forever! All 
you give up is about a meg 
of memory (for a full-screen 
photo). 

In the After Dark control 
panel, click Setup, click 
Wal!Zapper, click Set 
Picture, and choose the 
graphics file you want to 
use as a backdrop. 

Connectix Desktop Utilities and the shareware program Decor can 
perform the same trick. 

How do I get a cool sound to play when I turn on the 
Mac? 
A. Drop it into your System folder's Startup Items 
folder. 
Any sound fi le you put there gets played when you turn on the Mac. 
If you put several files there, they' ll play in alphabetical order. 
This only works, by the way, with standard double-clickable System 7 
sound files. 

How do I set my Disk Cache correctly? 

A. 32K per megabyte of memory in your Mac, unless 
you have System 7.5. 
The Disk Cache is a special feature of your Memory control panel (see 
Figure 7). It accelerates your Mac by keeping track of the little tasks you 
do most often - menu commands, folders you open, and so on -and 
storing them in this special portion of memory that it sets aside. 
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Figure 7: The famous Disk Cache 
selling is al lhe lop o f lhe Memory 
conlrol panel. 

Trouble is, the more of your Mac's memory you reserve for the Disk 
Cache, the less memory is available for your programs. So finding the 
correct setting is a balancing act, made no easier by the somewhat s illy 
rules you're about to read. As you read above, the first ru le of thumb is 
to ded icate 32K of memory per megabyte installed in your Mac. If your 
Mac has 4 megs of RAM, set the cache to 128K and forget it. 
The second ru le, however, is that there is a bug in the Disk Cache (in 
Systems befo re 7.5). If you set the cache higher than 512, you' ll actually 
slow down your Mac! Therefore, if you run any System earlier than 7.5, 
no miltter how much RAM your Mac has, don' t set the cache higher 
than 512K. 

Fortunately, in System 7.5, Apple created a whole new cache fea ture 
that doesn' t include that bug. If you have this (or a la ter) operating 
system, there is no 512K limit. Set the Disk Cache as high as you can 
afford, keeping in mind that doing so eats RAM that your programs 
could use. 

Can I print a list of what's on a disk? 

A. You sure can. 
Double-dick the d isk's icon. Turn the printer on. Choose Print Window 
from the File menu. That's it. 

This file is more than 1.4MB. How do I copy it onto a 
floppy disk? 

A. Compress it, or break it up. 
Either way, you' re going to need more software. Various programs, 
called things like Stufflt, DiskDoubler, and Now Utilities, let you either 
encode a file into a compressed format, or break it up into smaller 
chunks. Either technique le ts you fit a big file onto floppies. Bear in 
mind, however, that restoring that fi le back onto a hard drive requires 
that smne progrmn. 

(Of course, I' m assuming you've already checked the kiud of disk 
you' re using. The high-density type, marked with a big upside-down 
HD logo beside the sliding shutter, holds nearly twice as mucl1 infor­
mation as the more common double-dens ity type.) 



Chapter 3: America Online & the Internet 15 

Chapter 3: 
America Online & the Internet 

My kid cuts off my connection every time she picks 
up the extension downstairs. What I can do? 
A. Buy a Radio Shack Teleprotector, Item #43-107. 
It makes all other phone extensions go dead when you are - or your 
modem is- using the phone. 

How can I stop the spinning beachba/1 on America 
Online? 
A. Double-dick an AOL text file or mail file. 
Sometimes, while waiting for the "host has failed to respond" message, 
the cursor turns into a spinning beachball that looks like a BMW logo. 
Pressing Command-period doesn't stop the beachball, and you can' t to 
do anything while it's spinning. 
To stop the spinning beach ball and regain control of your software, 
switch back to the desktop, and double-click an AOL text file or mail 
file that you had previously saved onto your hard drive. If you don' t 
have one handy, choose New Memo from the File menu, and save the 
memo onto the desktop. When the beachball starts spinning, click on 
the desktop to switch to the Finder, then double-click the memo. 
Of course, stopping the beachball cursor doesn' t get you where you 
were trying to go- it doesn' t let you read the message you were trying 
to open, for example. However, it does re turn control to you, so you can 
go do something else until the host feels more responsive. 

Whenever I quit AOL, it says I have //information to 
be sent and/or received." What's that? 
A. Apparently, you haven't read (or sent) all your 
e-mail yet. Or you haven't downloaded the files you 
marked for future delivery. 

Fig. 8: Either you haven't read or sent your mail. or you haven' t transferred the files 
you m arked for delivery. 

A Are y ou sure !JOU IUont to sign oH ond 
'-1 quit ? You hnue lnlurmet lon to be s.enl 

oulllnr ruu•luo iJ . 

C: Oull I Sign Off 

I rln\hSes•lon ) I ro nrtl ) 
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Do you see the message shown in Figure 8 every time you try to sign 
off AOL? It's a remi11der that you have fi les or e-mail to upload or 
download, you haven't read all your incoming mail yet, or haven' t sent 
all the mail you've written offl ine, or you've marked some software for 
future downloading but haven't downloaded it yet. Here's how to clear 
out all three of these information types: 
• E-mail not yet read: choose Read New Mail from the Mail menu 

• £-mnilnot yet sent: choose Read Outgoing Mail from the Mail 
menu 

• Software not yet downloaded: choose Download Manager from 
the File menu 

What is the Internet? 

A. A network of computer networks. 
The Internet is a network of computers that speak a common language. 
All of these computers can exchange information - over the world's 
telephone wires. 
No one person or organization owns the IJ1ternet. The networks that 
compose the Internet are an exotic mix of educational, government, and 
commercial organizations. The Internet encompasses most of the inhab­
ited globe, and spans a broad spectrum of beliefs, nationalities, 
languages, politics, and Jaws. 

What can you do on the Internet? 

A. Exchange e-mail; get files; read public discussions; 
do research; type in live conversations; and explore 
the World Wide Web. 
The Internet isn't One Big Thing. It's divided into different services 
(or resources); each requires a different software program. Fortunately, 
these programs are generally free. You can download them from 
America Online o r the Internet itself (try http://www.shareware.com on 
the Web). 

• Electronic mail is the most useful Internet service. You can send 
e-mail to a friend anywhere in the world for pennies. Your e-mail 
arrives in minutes. FedEx must hate this stuff. You use a program 
like Eudora to send and receive e-mail (un less, of course, you 're 
on America Online or a similar service). 

• File Tm11sjer Protocol (FTP) means software you can download 
from FTP sites around the world. For example, Apple's latest 
sofh-vare updates are always posted to an area called 
ftp.apple.s11pport.com. Fetch is a popular FTP program. 
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• Usenet newsgroups are the Internet equivalent of public bul­
letin boards. Newsgroups give the Internet its color and 
sense of community. There are 20,000 newsgroups, on every 
conceivable topic- the weirder, the better. One popular 
newsgroup-reading program is News Watcher. 

• Gopher is a menu-based system for retrieving information 
from databases. Some university libraries have made their 
card catalogs available through Gopher. (Popular program 
for accessing them: TmboGopher.) 

• The World Wide Web integrates text, pictures, sound, and 
video into convenient, point-and-click pages (screens). 
Software required: Netscape Navigator or Microsoft 
Explorer. 

• Internet Relay Chat (lRC) lets groups of people type messages 
to each other in real time, like an Internet CB radio. Different 
channels discuss different subjects. Typical software used: 
Global Chat. 

How do I get connected? 

A. The easy way: Sign up for an online service. 
The macho way: Find an Internet access provider. 
If you'd rather not spend yom first weekend of Internet exposure 
mucking around in technical settings, sign up for America Online. 

17 

It offers easy, safe access to most Internet features. And for occasional 
use, an online service ($10 for five hours) is less expensive an a genuine, 
direct Internet account (example: about $20 per month, fla t fee); na tu­
ra lly, if you get addicted to the Net, the flat-fee system is much better. 
If the smooth, paved access road of an online service is too sissified 
for you, you can also subscribe directly to the Internet. This involves 
finding a local or regional company that's an Internet sel-vice provider. 
In exchange for a monthly fee, this company will provide you with 
more complete Internet access than the big online services. You provide 
your own sofh-vare and knowledge of how to use it. (Easy way to find a 
service provider and get the Internet programs you need: use the Apple 
Internet Connection Kit, which makes it all pretty easy.) 
Realize, however, that these companies offer no content of their own -
no Time magazine, no encyclopedia, no stock quotes, none of the orga­
nized, popular features of online services. A d irect Internet connection 
is also, needless to say, harder to use than an online service. 
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Where do I find all the good Mac programs on the 
Internet? 

A. At sumex-aim.stanford.edu and 
mac.archive.umich.edu. 
If you're on the Internet, I'll assume you know how to find a particular 
software area (FTP site). Sumcx-aim.stnnford.edu and mnc.nrchive.umich.edu 
are the worldwide Internet centers for Macintosh shareware and other 
files. If you're using the Web, the best Mac-software headquarters is 
l1ttp:/lwww.sharewnre.com. 

How do I use the files posted in newsgroups? 

A. It's Stufflt Expander to the rescue. 
While it may seem odd to discuss files among newsgroups- which 
are normally associated only with discussion- some newsgroups do 
indeed offer files to download. These newsgroups' names contain the 
word binaries. 

To use a file- a picture, sound, or program- from a binaries news­
group, save the message onto your hard drive. Large files have been 
split into multiple messages, so make sure you get all of the parts, 
usually labeled "Part 1/5, Part 2/5," and so on. Now combine themes­
sages into one big text file. You cnn use copy and paste to combine the 
parts, but it's easier to use a shareware program like BBEdit Lite (use 
the Concatenate Files command). Finally, drag the text fi le onto the 
Stufflt Expander icon to convert it into a genuine Mac file. (Get Stufflt 
Expander from an online service or the Internet itself, if you can find it.) 
Nobody ever said the Internet was easy. 
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What's netiquette? 

A. Netiquette means online etiquette - more rules 
to avoid nasty e-mail from irritated veterans. 
Here are three things to avoid: 
• DON'T TYPE IN ALL CAPITAL LETTERS LIKE THIS. ALL 

CAPS IS HARD TO READ AND VERY RUDE. IT'S LIKE 
SHOUTING IN SOMEONE'S EAR. AREN'T YOU GLAD 
THIS WHOLE BOOK ISN'T IN ALL CAPS? 

• Don't read, write, or pass on Make Money Fast and other 
pyramid schemes. These schemes violate federal fraud laws. 
What's more, they annoy the heck out of almost everyone. 
(By the way, the scams don't work, either.) 

• Don' t send unsolicited advertisements. The only news­
groups where you may post advertisements are in the 
biz.marketplace or for-sale newsgroups. Even then, you 
should limit the number of groups you post to. Posting the 
same message to dozens of newsgroups is called spammi11g, 
after the Monty Python skit where a group of Vikings drown 
out conversation by chanting "spam, spam, spam, spam, 
spam," etc. Spamming will make a lot of people mad, and 
can result in the loss of your Internet account. 

What's a LOL and a:-)? 

A. LOL is an abbreviation, and :-) is a smiley face 
turned sideways. 
To save typing online, many people abbreviate expressions like laughing 
out loud and fo r what it's worth: LOL and FWIW. When people want to 
let you know they' re kidding (or serious), they use little smileys, also 
known as emoticons. The classic smiley is:-), which, if you rotate your 
head 90 degrees to the left, looks like a smiley face. 

There are zillions of abbreviations on the Internet, and twice that many 
smileys. You can buy entire books filled with smileys, but the ones 
below are all most people need. 

BTW 
HTH 
I MHO 
IMO 
LOL 
ROTFL 
RTFM 

by the way 
hope this helps 
in my humble opinion 
in my opinion 
laughing out loud 
rolling on the floor laughing 
read the f&%.&!! manual 

TIA 
YMMV 
:-) 
:-( 
;-) 

:-1 

thanks in advance 
your mileage may vary 
Smiley 
Frowney 
Win key 
Seriously 
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What's .sit, .hqx, etc? 
A. Those letters at the end of a file name tell you 
what kind of file it is. 
If you've spent much time online, you know that most files are stored 
in a compressed format so they take less time to download . You also 
know that there are several different compression formats, with Stufflt 
being the most common for the Macintosh. You can tell that a file has 
been compressed with Stufflt - the file's name ends in .sit. 

Hold on to your hat: there are many other compression programs on 
the Internet. What's more, some files have been encoded into text. The 
encoding process converts a typical Macintosh-format data file into a 
long, gibberish-looking text file that can be transferred through comput­
ers that wouldn't understand a Mac file format. A piece of software that 
has been thus converted into text is said to have been bi11hexed. 
Most of the files at Macintosh FTP sites have been binhexed. If you 
open a binhexed file in your word processor, you' ll see that it begins 
with the line "(This file mrtsf be converted with Bin Hex 4.0)." There is a 
program called Bini-lex 4.0, but it has some bugs. Use the free program 
called Stufflt Expander instead. You can get it from an FTP site, or very 
easily from an online service. 

In fact, there are many more forms of file compression and text conver­
sion. All you need to know is that Stufflt Expander, along with the 
accompanying DropStuff with Expander Enhance1~ can restore them to 
normal Mac files. Including any format listed in Table 1. 

Table 1: Common filename extensions for compressed and 
encoded files 

Name suffix 
.arc 
.zip 
.sit 
.cpt 
.z 
.gz 
.hqx 
.uu 
.sit 
.cpt 

Compression method 
arc 
PKZip 
Stufflt 
Compact Pro 
UNIX compress 
GNU Zip 
binhex 
uuencoded 
Stuff It 
Compact Pro 

You may also encounter file-name suffixes that have nothing to do with 
compression. For instance, horn.wav is a smmd in WAY format (a PC 
format). You' ll learn these things as you go along. 
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How do I find someone's e-mail address? 
A. Call them up. 
Believe it or not, the easiest way to find a friend's email address is to 
pick up the phone. It sure would be nice if there were some kind of 
up-to-da te, electronic, worldwide directory of [nternet participants. 
Trouble is, the Internet's millions of members change hourly - trying 
to maintain an accurate directory would be a futile task. There are some 
ways to search for email addresses - there are even entire books, called 
"Internet White Pages" - but none of them is very good. 

What are GIFs and /PEGs, and how do I open them? 

A. They're picture formats. Use GIFConverter, 
GraphicConverter, America Online, or Navigator. 
GIF (pronow1ced like the peanut butter) stands for Graphics 
Interchange Format. )PEG (pronounced jay-peg) stands for Joint 
Photographic Experts Group. Both graphics formats are widely used 
online, because they use compression to reduce downloading time. 
lf you have America Online 2.5 or higher, you're in luck- the pro­
gram can open GIFs and }PEGs (just use the Open command in its 
File menu). Web-browser programs, like Navigator and Explorer, can 
open these graphics files, too. Otherwise, download GIFConverter or 
GraphicConverter (shareware graphics programs). Launch the graphics 
viewer and choose Open from its File menu to open the pictures. 
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Chapter 4: 
Speech, Music, and CD-ROM 

How do I watch TV on a Mac? 
A. You need a Mac with video inputs. 
The Mac needs a special circuit board inside if it's to double as a TV set. 
Here are your options: 
• a Quadra AV, Centris AV, or Power Mac AV model- or a 

recent hig h-end Power Mac, like a 7500, 7600, or 8500 

• a Performa /Quadra / LC 630-something, or a 5200-some-
thing, w ith the optional Apple TV card installed 

• a Mac TV (remember that model?) 

Anyway, once you have your Mac equipped, you also need to figure 
out some way to bring a TV signal to it. That means connecting it to 
your cable TV cable, or running a cord from your VCR to the Mac, or 
using an antenna with the right kind of adapter jack. 

Can my Macintosh play CD-ROM discs for a PC? 

A. Yes. You may not hear the sound, though. 
If you've equipped your Mac with a DOS card (from Apple, Reply, 
Orange, or another company), you should be in good shape. You can 
play CD-ROM d iscs designed to ru11 on PCs only. 
If you're running SoftWindows, you may not hear the sound or music, 
unless you have the most recent version (it has to say, "Sound Blaster 
compatible"). And if you have neither a DOS card nor Soft Windows, 
the answer is no: you can't use PC-only CD-ROM discs on your Mac. 

I'm pressing the eject button on my Mac, but the CD 
won' t ej ect! 
A. No wonder. You must drag the CO's icon to the 
trash ( onscreen) first. 
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When I start up my Macintosh, it says that QuickTime 
could not be installed because it was already 
installed. 
A. You have two copies of the Quicklime extension. 
Open your System Folder, open your Extensions folde1~ and remove 
one of the copies of QuickTime. (Use the Get Info command on each 
one to find out how old it is, so you' ll be sure that you' re throwing 
away the older one.) 

How do I make my Mac talk? 
A. Get System 7.5 and install PlainTalk. 
System 7.5 comes w ith something (in your Apple Extras folder) called 
PlainTalk Text-to-Speech. If you install it, then when you launch 
SimpleText, a Sound menu appears. Just type something or paste some 
text, and choose Speak All from the Sound menu. You'll hear the Mac 
read your text- in a nasal, Norwegian-sounding voice, but unmistak­
ably clear. (You can also make ClarisWorks, America Online, and 
WordPerfect talk.) 

If you have System 7.5 on a CD-ROM, you're in for a real treat. In that 
SimpleText Sound menu is a Voices submenu that lists 18 different voices. 
They range from standard male and female to biz ilfre, bubbly-sounding 
aliens. (For these options to work, you must first install the Plain Talk 
software from your CD-ROM, which should put a Voices folder inside 
your Extensions folder.) 
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Chapter 5: 
Troubleshooting & Error Messages 

How come the floppy says ~~o items/ // but I can/t copy 
a 45K file onto it? 

A. There's stuff in the Trash. 
You may see only one Trash can on your screen. But believe it or not, 
every disk holds an invisible Trash folder. Even when no icons appear 
in a disk's window, the d isk may actually be full - of stuff in its invisi­
ble Trash folder. 

To see what's in there, open your Trash can icon. To get rid of the 
trashed items, of course, empty the Trash. Now you really have 0 items 
on that floppy. 

rve erased this BOOK disk twice. It still only has 764K 
available. Whars up with that? 
A. You're forgetting about its invisible database. 
No 800K d isk ever holds 800K, and no 1.4MB disk ever holds 1.4MB. 
Every disk, even w hen completely empty, sets aside a few K for its 
invisible desktop files. These files form a database that keeps track o f 
w hat files are on the d isk, where they' re located on the d isk's surface, 
and w hat their icons look like. 
And besides, it's rea lly not such a gyp- if you had a PC instead of a 
Macintosh, your 800K d isks would only hold 720K apiece. 

I copied a 2K file onto my hard drive, and it 
ballooned to 64K! 

A. The answer is technical, but mind-blowingly 
interesting. 
Every disk, behind the scenes, is d ivided up into thousands of little 
parking places for information called blocks. Every hard drive has 
exactly the same nrtmber of these blocks, no matter what its capacity. 
Therefore, a 500MB hard drive's li ttle blocks are proportionately la rger 
than a 200MB hard d rive's. 
It so happens, fu rthermore, that no file on your d isk can take up less 
space than one block. A teeny-tiny text file that, in reality, is only 1 K in 
size, nonetheless requires a ful l block's worth of space on your hard 
drive- w hich, since a typical hard-d rive block is 8K or even 32K, 
means that several K are wasted. 

Now suppose that tiny text file is on a floppy disk whose blocks are lK 
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apiece. Naturally, if you copy that file o nto a 4,000MB hnrd drive whose 
blocks are 64K apiece, you'll see that tiny text file bloat to 64 times its 
actual size. Fortunately, you can still sleep well, secure in the knowl­
edge that, when copied back onto a floppy, that text file will shrink 
back to its original l K size. 

Do I need a hard-disk optimizer, whatever that is? 
A. Not unless your hard drive has been 90% full for 
weeks. 
Over time, as you create, edit, and delete files on your drive, things get 
a little messy behind the scenes. The Mac may split a file into several 
pieces if one big hunk of space isn' t available on the hard drive. (Your 
drive, to use the geek term, becomes fragmented.) 
Of course, that means that your fi les take longer and longer to open, 
because the hard drive must look farther and wider to find the pieces. 
Eventually, if the slowness gets bad enough, some people buy a pro­
gram called a disk optimizer; its purpose is tore-stack every file on your 
drive, moving them around and rejoining their pieces. An opt-imized 
drive is faster than one with a lot of split-up fi les. 
You' ll notice the most dramatic speed difference if your drive has been 
nearly fu ll for a long time - in other words, if most of your fi les are 
split in to pieces. 
The best-known optimizers are Speed Disk (part of Norton Utilities) 
and DiskExpress. 
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When I try to give my hard drive a new icon/ I get this 
message: _,_,This command cannot be completed 
because it cannot be found. /I 

A. Although this is a technical problem, the solution 
is easy: use Disk Rejuvenator. 
Disk Rejuvenator is free; it's available on America Online or similar 
services. 

How do I turn off that stupid startup test page? 

A. The on/off switch is in the LaserWriter Utility 
program. 
Lord knows why laser printer manufacturers design their products to 
spit out an irrelevant test page every time they' re switched on. Anyway, 
on the disks that came with your Mac, you' ll find a little program called 
LaserWriter Utility or Apple Printer Utility. Launch it. From the Options 
menu, choose Set Startup Page- and click the Off button. 

Every time I open the Chooser/ it has forgotten the 
printer choice I made last time. 

A. Just because the correct icon is never highlighted 
doesn't mean the Chooser forgot. 
The Chooser is actually used to choose more than just printers. All 
kinds of icons might show up there: for file sharing, for your fax/modem, 
for your sca11ner, and so on. Because of this arrangement, the Chooser 
actually remembers several selections at once. That's why no one icon 
is ever highlighted when you open the Chooser. 

Printing takes forever. Can I speed things up? 

A. Yes, especially if you're willing to spend some 
money on it. 
If not, you have only two options for speeding up printing. 
• Turn off background printing. Do this by opening the 

Chooser and clicking the Background Printing Off button. 
• Make your document less fancy. In particular, using fonts 

that aren' t part built into your laser printer makes printouts 
take longer, because your Mac must transmit that font infor­
mation before the printout can begin. The fonts that are built 
into most laser printers are Times, Helvetica, Helvetica 
Narrow, Avant Garde, New Century Schoolbook, Courier, 
Bookman, Palatine, Za pf Chancery, Symbol, and Zapf 
Dingbats. 
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If slow printing has annoyed you to the point of opening your check­
book, the rules are simple: the Macintosh and the printer are equally at 
fault. Upgrading either one - or both - to a faster model will take 
care of your slow printing headaches. 

Why does my Mac sometimes take so long to start up? 
A. Because it wasn't shut down normally last time. 
All recent Macs perform a lengthy disk-integrity check if they start up 
after having been shut down improperly. You'll notice the extra delay 
between the appearance of the happy Mac icon and the "Welcome to 
Macintosh" message. 
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What's a ''bad f-line instruction//? 
A. It's a bad mistake some programmer made. 
As your software executes hundreds of computer instructions per sec­
ond, it may enter an F-line instntction- a d irection to consult the math 
chip, or floating point writ (FPU), attached to your main processor chip. 
Trouble is, some pre-Power Mac models don't have an FPU chip. Up 
pops this message. 

But you may as well ignore that explanation; most people encounter the 
"bad F-line instruction" message on Macs that do have an FPU. 

In other words, this message appears most often in error- basically, 
the Mac lies. Your software may be trying to access a nonexistent mem­
ory location, or it may have encountered the letter Fin the wrong place 
in the programmer's code! 

If you're getting a lot of this message, try re-installing the program 
you' re using. It that doesn't work, do a "clean install" of the system 
software, as described in the actual, 400-page version of this book. 

It says, '~Application could not be found/' 
What gives? 
A. You' re double-clicking a document of unknown 
origin. 
Possibilily # 1: You're try ing to open a memo that was written in 
ClarisWorks, but you don't have ClarisWorks. The Mac is letting you 
know that the program you need to read the fi le isn't on hand. 
Possi/Jilily #2: You do have the program that created the troublesome 
document, but the Macintosh has gotten muddled in its little head. It 
happens sometimes. You need to make it re-learn the relationships 
between your programs and your docum ents. You do this by "rebuild­
ing the desktop." (See FAQ #48.) 

Possibilin; # 3: You're double-clicking a tex t, graphics, or music file 
tha t's so generic that your Mac can't decide wlrich of your programs to 
use. Some file formats, such as plain-text fi les (for typing) and PlCT 
files (for graphics), can be opened by almost any Mac text or graphics 
program, respectively. These file formats are terrifically useful, because 
they le t you exchange information among programs. Jn the case of 
plain text files (also called ASCil files), they even le t you exchange 
information among different kinds of comprtters, such as Macs and IBM 
clones. But because the Mac doesn't associate such generic fi les wi th 
any particular program on your hard drive, you get the "application 
not found" message. 

Fortunately, this third scenario is becoming a thing of the past. Starting 
with System 7.5, a new control panel called Macintosh Easy Open handles 
this generic-document problem. When you double-click a generic docu­
ment, Easy Open shows you a list of every program you own that can 
open it. You choose which to use to open that mysterious document. 
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lf you don't have Easy Open, you can sti ll get around this generic­
document problem manually. Instead of double-clicking the problem 
document icon, launch the program you want to open it with first. Then, 
from within that program, choose Open from the File menu, and select 
the mystery document lim I way. Figure 9 should make this d earer. 

e lhe dOCUtrUU'tl "hOUUt., COukl nu l bt 
opened, beceute I he applluUon program 
that treated It t oula no t be found. 

DO 
lr..Hrl ~A .... ~«d: 107 ~ ... 

0 
"'' 

D 
-~· l b .. .. 

C)toblnnt 

Figure 9: Top: W hen you double-click 
a standard TIFF graphics file, you'll pro­
bably get the "application busy or 
missing" message. Bottom: O ne solution 
is to launch a program that can open it, 
such as ClarisWorks, and use the Open 
command. The troublesome file will 
show up in the list of files . 

Isn't there a table someplace that tells what all the 
error messages mean? 
A. There is now. 
This stuff is, as you're about to discover, completely unhelpful; it's 
designed for programmers to understand (barely), not us. But so many 
people have requested this information tha t I' m printing it here as a 
public service. 
There are two categories of error messages. Those with positive num­
bers are the so-ca lled OS errors (which stands for deep doo-rloo). These 
are serious system crashes that requi re you to restart the machine. 
Errors with negative numbers aren't so severe; usually you just have 
to click an OK button to proceed. 
10=01: Bus Error - The Mac has tried to access memory that doesn't 
exist - for example, the program you' re using assumed that the Mac 
has more RAM ava ilable that it actually does. The problem is usually 
that you're using out-of-date software. 

10=02: Address Error - Mac Plus and SE only: your processor chip 
has tried to access an odd-numbered memory location when it should 
have accessed an even-numbered one. 
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10=03: lllegal Instruction- Your processor has a fixed, specific vocab­
ulary; if the software issues an instruction using lingo your processor 
doesn't understand, you get this error message. 
10=04: Zero Divide Error- When programmers test their works in 
progress, they might deliberately instruct the computer to divide a 
number by zero, to see how well the program handles errors. Trouble is, 
they occasionally forget to take this instruction out. You are the lucky 
benefactor. 

10=05: Range Check Error- The software checked to see if a number ­
part of some internal calculation- is within a certain range. It wasn't. 
10=06: Overflow Error- The Mac allots a certain amount of space for 
each number it processes. You see this error if a number was too big for 
the space the software allotted for it. 

10=07: Privilege Violation- For programmers only: your Mac 
attempted to process a command in User mode instead of Supervisor 
mode. Bad move. 

10=08: Trace Mode Error - When debugging software, p rogrammers 
sometimes walk through it, line by line, using something called Trace 
mode. If you see this message, your processor chip has accidentally 
switched into Trace mode. 

10=9 and 10=10: Line 1010 & 1111 Trap - Once again, the software has 
issued an instruction that the processor chip doesn' t understand . 
10=12: Unimplemented Core Routine -As with the fD=04 error, this 
results from a leftover instruction from the debugging process. 
10=13: Uninstalled Interrupt - An interrupt is a moment during the 
running of a program when an external device, such as the keyboard or 
the disk drive, asks for attention. If there aren't any instructions in RAM 
that tell the Mac how to talk to that device, you get this error message. 

10=15: Segment Loader Error - To conserve memory, a non-Power 
Mac program is loaded into RAM in segments as needed. A piece of sys­
tem software called the segment loader oversees this swapping process. 
If, for some reason, the segment/onder can't do its thing, this error 
resu lts. 

10=26-27, 30-31: Missing Packages- A package is a ready-to-run set of 
system suftwar~ instructions that handles a particular task, such as ini­
tializing a disk. If a package is damaged, one of these messages tells 
you so. You need to perform a "clean re-install" your system folder. 
10=25: Memory Full Error-You've probably run out of memory, 
although this message may appear erroneously. 
10=26: Bad Program Launch- The Mac couldn' t open the program 
you tried to launch. Try re-installing it. 
10=20: Stack Ran into Heap. Just as in 10=25, you've probably run out 
of memory, a lthough this message may appear erroneously. 
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Negative Error Codes 
There are many more negative-numbered error messages than positive. 
Furthermore, they make even less sense to the non-programmer. 
(Example: "Packet too large or first entry of the write-data structure 
d idn' t contain the full14-byte header." Thanks a bunch.) 
This table provides the general categories for each number range, along 
with a few that actually make sense to human beings (such as "bad 
floppy disk"). 

Table 2: Negative-numbered errors 

Error number 
0 through -8 

- 9 through -21 

-17 through - 61 

-34 

-35 

-37 

- 39 

-41 

-42 

-44 and -46 

- 53 through - 57 

- 60 

- 64 through -66 
-64 through - 90 

- 91 through - 99 
- 108 through -11 7 
- 120 throug h -1 27 
-126 through - 128 
- 130 through - 132 
- 147 through - 158 
-185 through - 199 

What causes it 
General system errors 

Color Manager errors 

System errors involving files and 
disks (1/0 , or input and output) 

The disk is full 

No such disk, or the Mac can't find 
the disk it's looking for 

Something is wrong with the name 
of a file (for example, the name 
includes a colon) 

A corrupted file is on the disk, or 
the disk is having problems 

The file is too big to fit in memory 

Too many files are open 

The disk is locked 

Something's wrong with the 
request for a disk 

Something's wrong with the disk 
directory 

Font problems 
Problems reading disks (timing and 
track troubles) 

AppleTalk errors 

Various memory allocation errors) 

HFS errors (disks, directories) 

Menu problems 

More HFS errors 

Color management problems 

Resource Manager errors 
(problems managing data 



Chapter 5: Troubleshooting and Error Messages 33 

-200 through -232 

-250 through -261 
Problems with sound or sound files 

Problems with the MIDI Manager 
(music data, used with synthesizers) 

"'You do not have enough access privileges.'/ Why not? 

A. Apple is trying to save your System Folder from 
disaster. 
If you find this child-proofing feature annoying, it's easy to defeat. 
Open your Control Panels folder. If you see an icon called Performa, 
double-click it; otherwise, open the one called General Controls. 
In either case, you 'll see a checkbox called "Protect System folder." 
Turn it off. Congratula tions: you now do have enough access privi leges. 
Incidentally, there are two Jess common circumstances in which you 
might see this warning. The first is if you keep your programs in a 
folder called Applications; there's also a "protect Applications folder" 
checkbox in the General Controls panel. When this feature is on, you 
can't change the Applications folder 's contents. Finally, if your Mac is 
on a network, "access privileges" may refer to permission to examine 
the hard drives of other people on the network. 

My Mac/s clock keeps going back to 1904 or 1956. 

A. Your Mac's "five-year" lithium backup battery is 
dying. 
You need to contact an Apple technician to replace it. 

How come all my icons show up as blank pieces of 
paper? 

A. Probably because your Desktop file is corrupted. 
The Desktop file is the invisible database where the Mac stores the 
icons for all your files- as well as the rela tionship information (which 
kind of document gets which icon). If this file gets damaged or con­
fused, as it sometimes does, it gives up on your icons. All document 
files show up looking like blank pieces of paper, and all programs look 
like generic diamonds. 

Fortunately, slapping the Desktop file back into coherence is simple. 
The process is called rebuilding the desktop - start the Mac with the 
Shift key down (until the screen says "Extensions Off"), then immedi­
ately press Command and Option until you 're asked if you want to 
rebuild the Desktop fi le. 



34 

• • 

MacFAQs 

I found this ""rescued items'' folder in my trash. What 
are they? 
A. They're the Mac's attempt to recover from an 
unfortunate crash. 
Some programs, especially Microsoft's, create invisible temporary files 
on your hard drive - sort of a scratch pad for themselves. Normally, 
when you quit such a program, it automatically deletes those files. 
But if you don' t quit normally- in other words, if you have a system 
crash, or you force quit, or you just switch off the Mac without shutting 
down properly - that program doesn't have a chance to delete its tem­
porary files. The Mac thinks it's doing you a favor: when you restflrt the 
next time, it puts those temp files together into that Rescued Items fold­
er. Sometimes you can even recover some unsaved typing by opening 
one of those temporary files. Otherwise, just empty the trash and forget 
about it. 

Can Word 5 read Word 6 files, and vice-versa? 
A. Word 6 reads Word 5 files directly. Word 5 needs 
the free translator file. 
The translator fi le, called Word 6.0 for Windows & Macintosh, must be 
placed in the Word Commflnds folder, in the same folder as Word 5 
itself. You can get this trflnslfltor for free from America Online a nd other 
services. (Word 4, Word 5, find Word 5.1 files, by the way, are freely 
interchangeable.) 

Why don't the keys on my number pad work in 
Microsoft Word? 
A. They're supposed to be used for navigating your 
document. 
For example, the 9 and 3 keys scroll up and down one screen, respectively. 
To switch those keys back to typing numbers, press the Clear key in the 
upper-left corner of the pad (Word 4 or 5) or Shift-Clear (Word 6). Hit 
that combination again to switch back to navigfltion mode. 
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Is there any way to make my FileMaker database 
stay sorted? 
A. Yes - but there's no easy way. 
As you've noticed, FileMaker (and ClarisWorks) databases don't seem 
to stay sorted after you've sorted them. As soon as you start working 
with lhe da tabase, lhe records seem to be instantly out of order. 
The only way to keep your records permanently sorted is to sort them; 
export them, using the Import/Export command in the File menu; 
delete a ll the records from the database; and then re-import the data 
you exported. Thereafter, you can preserve the sorted order by adding 
new records in alphabetical order (instead of at the end). 

Isn 't there any way to change the font permanently 
for all my ClarisWorks documents? 
A. Yes. Create a blank stationery document called 
ClarisWorks WP Options. 
In other words, create a new word processor document. Change the 
font to something you like. (Change every thing else while you're a t it 
- the margins, the line spacing, and so on.) Choose Save from the File 
menu. In the next window, click the Stationery button. Give your new 
document the name ClarisWorks WP Options, and save it. 

From now on, every time you create a new word processing document, 
it will have the font you want. 

Is it worth buying an extended warranty like 
AppleCare? 
A. No, except maybe for PowerBooks. 
You almost never come out ahead, financially speaking, by buying an 
extended warranty on desktop computer equipment. Even if something 
does go wrong in, say, five years, the repair cost probably won' t be as 
much as you'd have paid in AppleCare for those five years. 

If you carry your Power Book around a lot, a service plan may make 
more sense; these are more fragile computers, and they're subject to a 
lot more abuse. 
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